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Przełom na rynku narzędzi EDA
dla elektroników, część 4

szereg dodatkowych informacji, przydat-
nych podczas projektowania, zamawiania
elementÛw lub montaøu urz¹dzenia. Defi-
niujemy je w†postaci parametrÛw, ktÛre
moøemy dodawaÊ do elementu na pozio-
mie biblioteki lub wprost na schemacie.
Edytor schematÛw DXP zawiera potÍøny

edytor parametrÛw, u³atwiaj¹cy zarz¹dza-
nie parametrami elementÛw. DostÍpny jest
z†poziomu menu Tools>Parametr Manager.
Po uruchomieniu, w†pierwszej kolejnoúci
okreúlamy zakres obiektÛw, ktÛrych para-
metry chcemy przegl¹daÊ lub modyfiko-
waÊ. NastÍpnie pojawia siÍ tabela Para-
metr Table Editor (rys. 2), ktÛra pozwala
na dodawanie i†usuwanie parametrÛw oraz
edycjÍ jednego lub wielu parametrÛw jed-
noczeúnie.

£¹czenie elementÛw z†baz¹
danych
Projektowanie w†programie nVisage lub

Protel jest jednym z†etapÛw opracowania
produktu. Aby sprawnie zarz¹dzaÊ ca³ym
procesem projektowania (zw³aszcza w†wa-
runkach firmowych), wskazane jest zapew-
nienie przep³ywu danych pomiÍdzy úrodo-
wiskiem DXP oraz innymi systemami fun-
kcjonuj¹cymi w†przedsiÍbiorstwie, jak np.

W tej czÍúci artyku³u przedstawiamy zagadnienia dotycz¹ce
bibliotek elementÛw w DXP oraz mechanizmy wykorzystywane

przez Protela, ktÛre zapewniaj¹ synchronizacjÍ danych
wykorzystywanych w†projekcie. To w³aúnie te mechanizmy
dbaj¹ o†to, aby po³¹czenia na p³ytce drukowanej úciúle

odpowiada³y schematowi.

W†programach nVisage i†Protel DXP sym-
bol schematowy jest ìcentrumî zawieraj¹-
cym kompletn¹ definicjÍ elementu. Podsta-
wow¹ reprezentacj¹ elementu jest symbol
graficzny, wykorzystywany do umieszczania
na schemacie. Poza symbolem schemato-
wym, uøytkownik moøe korzystaÊ takøe
z†do³¹czanych do niego modeli, ktÛre opi-
suj¹ m.in. obudowÍ elementu, jego paramet-
ry elektryczne (wykorzystywane podczas sy-
mulacji) itp. nVisage obs³uguje kilka rodza-
jÛw modeli, w³¹czaj¹c w†to: footprint (uøy-
wany na PCB), symulacyjny (uøywany pod-
czas symulacji obwodu), VHDL, EDIF oraz
model analizy sygna³owej. £¹cze do kaøde-
go wymaganego pliku modelu jest dodane
do elementu, b¹dü na poziomie biblioteki
elementÛw lub bezpoúrednio na schemacie.
Tak samo, jak informacje wizualne

i†elektryczne s¹ reprezentowane przez
symbol schematowy i†zwi¹zane z†nim pli-
ki modeli, rÛwnieø wiele innych atrybu-
tÛw lub parametrÛw moøe byÊ zawartych
w†opisie elementu. Mog¹ to byÊ np. para-
metry elektryczne waøne dla projektu (jak
moc lub tolerancja parametrÛw elementu),
jak rÛwnieø informacje potrzebne przy
produkcji (takie jak numer magazynowy
lub numer referencyjny w†katalogu dostaw-
cy). Do opisu elementu moøemy dodaÊ do-
woln¹ liczbÍ parametrÛw, zarÛwno w†bib-
liotece, jak i bezpoúrednio na schemacie.
Parametry mog¹ byÊ rÛwnieø powi¹zane
z†baz¹ danych, obs³uguj¹c¹ przyk³adowo
firmowy system magazynowy.

W³aúciwoúci elementu, w³¹cznie z†mode-
lami i†parametrami, dostÍpne s¹ z†poziomu
okienka dialogowego Component Proper-
ties (rys. 1).

Zintegrowane biblioteki
elementÛw
Zazwyczaj kaødy rodzaj modelu jest

zdefiniowany w†osobnym pliku zawieraj¹-
cym opis modelu lub bibliotece, z†ktÛrych
kaødy ma inny format. Potrzeba obs³ugi
wielu zrÛønicowanych formatÛw modeli
powoduje, øe nie s¹ one przechowywane
w†symbolu schematu, tylko po³¹czone
z†nim. DziÍki temu, jeden model moøe byÊ
powi¹zany z†wieloma elementami - np.
ten sam model symulacyjny wzmacniacza
operacyjnego moøe dotyczyÊ wielu elemen-
tÛw rÛønych producentÛw, podobnie jak
ten sam model obudowy (PCB footprint)
moøe byÊ identyczny dla wielu elementÛw
na schemacie. Takie podejúcie powoduje
niedogodnoúÊ, polegaj¹c¹ na tym, øe mu-
simy zarz¹dzaÊ wieloma plikami. W†biblio-
tece zawieraj¹cej duøo elementÛw, z†ktÛ-
rych kaødy wykorzystuje wiele modeli,
liczba plikÛw moøe byÊ ogromna.
Aby rozwi¹zaÊ ten problem, úrodowisko

DXP wspomaga tworzenie oraz obs³ugÍ
tzw. zintegrowanych bibliotek elementÛw.
Zintegrowana biblioteka elementÛw to
kompletny i†przenoúny pakiet symbolÛw
schematowych, obudÛw, modeli Spice,
VHDL, EDIF i†modeli analizy sygna³owej.
BibliotekÍ zintegrowan¹ budujemy, two-

rz¹c tzw. library package. Jest to specjalny
typ projektu, ktÛry okreúla, jakie elementy
wchodz¹ w†sk³ad biblioteki zintegrowanej.
Po skompilowaniu tworzy pojedynczy,
przenoúny plik biblioteki zintegrowanej
(*.IntLib). Taka skompilowana forma biblio-
teki nie moøe byÊ edytowana, ale moøe byÊ
dodana i†uøywana w†úrodowisku DXP po-
dobnie jak inne rodzaje bibliotek.

Zarz¹dzanie parametrami
elementÛw
Jak wspomnieliúmy wczeúniej, oprÛcz

wielu informacji elektrycznych i†graficz-
nych dostÍpnych w†symbolu schemato-
wym, opis elementu moøe zawieraÊ ca³y

Rys. 1. Właściwości elementów są
dostępne z poziomu okienka dialogowe−

Rys. 3. Widok okna Database Link

Rys. 2. Tabela Parametr Table Editor
pozwalająca na dodawanie, usuwanie
i edycję parametrów
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baz¹ danych elementÛw. Moøemy to osi¹g-
n¹Ê tworz¹c ³¹cza pomiÍdzy elementami
na schemacie i†zewnÍtrzn¹ baz¹ danych.
£¹czenie elementu z†baz¹ danych pozwala
na wprowadzenie dowolnych danych z†ba-
zy do elementu. Dane te mog¹ byÊ nastÍp-
nie wykorzystane podczas projektowania
lub w³¹czone do zestawieÒ elementÛw
tworzonych na zakoÒczenie projektu.
£¹cza s¹ tworzone pomiÍdzy paramet-

rami elementÛw na schemacie i†zewnÍtr-
zn¹ baz¹ danych za poúrednictwem tzw.
Database Link (plik *.DBLink) dodanego
do projektu. Program do realizacji ³¹cza
z†baz¹ danych wykorzystuje standardowy
interfejs ODBC systemu Windows lub
wbudowany interfejs do obs³ugi baz MS
Access i†MS SQL Server. Oparcie na
standardzie ODBC daje w†praktyce moø-
liwoúÊ sprzÍgniÍcia z†dowoln¹ baz¹ da-
nych.
Zestawiaj¹c po³¹czenie, w†pierwszej ko-

lejnoúci wybieramy bazÍ danych, nastÍpnie
wskazujemy pola tabeli, ktÛre bÍd¹ odwzo-
rowane w†postaci parametrÛw projektowych
oraz okreúlamy sposÛb aktualizowania
zmian. Wszystkie ustawienia moøemy
okreúliÊ za pomoc¹ narzÍdzia Database
Link (rys. 3).

Zarz¹dzanie aktualizacj¹
elementÛw
Istotny problem z†zakresu zarz¹dzania

elementami stanowi kontrola propagowania
zmian wprowadzonych w†elementach bib-

liotecznych do projektÛw, ktÛre ich uøy-
waj¹. Kreator Update From Library (rys. 4)
daje pe³n¹ kontrolÍ nad procesem aktuali-
zacji elementÛw, pozwalaj¹c na aktualiza-
cjÍ na jednym lub wiÍcej arkuszach sche-
matÛw aktywnego projektu, z†wykorzysta-
niem wybranej biblioteki. Aktualizacja da-
nego typu elementu moøe byÊ przeprowa-
dzona dla jego wszystkich wyst¹pieÒ
w†projekcie lub indywidualnie dla poje-
dynczych instancji.
Kreatora aktualizacji uruchamiamy z†me-

nu Tools>Update from Libraries. Jeúli jego
ustawienia nam odpowiadaj¹, wystarczy
klikn¹Ê przycisk Finish, øeby uruchomiÊ
aktualizacjÍ. Pojawi siÍ typowe okienko
funkcji ECO (Engineering Change Order),
widoczne na rys. 4, ktÛre pokazuje szcze-
gÛ³owo wszystkie zmiany, jakie zostan¹
naniesione. Klikaj¹c przycisk Execute
Changes, ostatecznie uruchamiamy proces
aktualizacji.
Jeúli zaleøy nam na indywidualnej aktu-

alizacji poszczegÛlnych wyst¹pieÒ tego sa-
mego elementu na schemacie, przechodzi-
my do drugiej strony kreatora, naciskaj¹c
przycisk Next. Na rys. 5 widaÊ, øe mamy
indywidualny dostÍp do kaødego elemen-
tu i†moøemy indywidualnie konfigurowaÊ
parametry aktualizacji. NastÍpnie przycis-
kiem Finish uruchamiamy nanoszenie
zmian, co powoduje start funkcji ECO
i†w†efekcie dokonanie odpowiednich
zmian w†projekcie.

Definiowanie regu³
projektowych PCB na
schemacie
Protel DXP pozwala na definiowanie,

juø na poziomie schematu, regu³ projekto-
wych PCB, ktÛre okreúlaj¹ szczegÛ³owe pa-
rametry obwodu drukowanego, jak np. sze-
rokoúÊ úcieøki lub wielkoúÊ odstÍpu po-
miÍdzy elementami na p³ycie.
Regu³y te dodajemy na schemacie w†po-

staci parametrÛw, wykorzystuj¹c przycisk
Add as Rule. ZasiÍg dzia³ania regu³y jest
uzaleøniony od miejsca na schemacie,
w†ktÛrym umieúcimy okreúlaj¹cy j¹ para-
metr. Przyk³adowo, regu³a zdefiniowana
dla elementu na schemacie bÍdzie siÍ od-
nosiÊ do jego odpowiednika na PCB, re-
gu³a okreúlona dla po³¹czenia na PCB ma

Rys. 4. Pierwszy krok działania kreatora
Update From Library pozwala m.in.
wybrać arkusze schematowe do zaktu−

Rys. 5. W drugim kroku działania kreato−
ra Update From Library mamy dostęp
do każdego elementu i możemy indywi−

zasiÍg sieci (net) zwi¹zanej z†danym po³¹-
czeniem.
MoøliwoúÊ definiowania regu³ PCB na

schemacie nie przeszkadza ani nie wyklu-
cza moøliwoúci ich okreúlania wprost
w†edytorze PCB. Jednak w†pewnych wa-
runkach jest to wygodniejsze, poniewaø
schemat ideowy pozwala proúciej wyod-
rÍbniÊ fragmenty, dla ktÛrych parametry
obwodu drukowanego powinny byÊ úciúle
okreúlone.

Interfejs do Systemu
Zarz¹dzania Wersjami
Kolejn¹ cech¹ Protela DXP, o†niebagatel-

nym znaczeniu dla wiÍkszych biur projek-
towych, jest moøliwoúÊ wspÛ³pracy z†sys-
temem zarz¹dzania wersjami. Systemy ta-
kie pozwalaj¹ na synchronizacjÍ pracy kil-
kuosobowego zespo³u nad jednym projek-
tem, u³atwiaj¹c utrzymanie spÛjnoúci pro-
jektu i†dostÍpnoúÊ najbardziej aktualnych
wersji dokumentÛw dla wszystkich cz³on-
kÛw zespo³u. Protel DXP posiada interfejs
kompatybilny ze standardem Visual Sour-
ceSafe. DostÍp do wszystkich funkcji sys-
temu zarz¹dzania wersjami odbywa siÍ
wprost ze úrodowiska DXP.

Synchronizacja projektu
Jednym z†zasadniczych wyzwaÒ stoj¹-

cych podczas projektowania PCB jest
utrzymanie zgodnoúci pomiÍdzy schema-
tem i†PCB. W†czasie pracy wprowadzamy
ci¹g³e zmiany - na schematach, na PCB
lub rÛwnoczeúnie w†kilku miejscach -
i†zmiany te musz¹ byÊ przenoszone do in-
nych dokumentÛw projektowych. Tradycyj-
nie (m.in. w†Protelu 99SE) jest to robione
za pomoc¹ rÛønego rodzaju plikÛw, na
przyk³ad za pomoc¹ listy po³¹czeÒ (netlist)
lub pliku ECO. Inaczej jest w†úrodowisku
DXP, gdzie synchronizacja jest wykonywa-
na bezpoúrednio pomiÍdzy schematem

Rys. 6. W tym oknie dialogowym jest
pokazywany stan wzajemnych powiązań
elementów

nVisage vs Protel DXP
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Dodatkowe informacje mo¿na uzyskaæ w firmie
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Dodatkowe informacje

i†PCB. Synchronizacja w†DXP jest rÛwnieø
dwukierunkowa, to znaczy, øe zmiany mo-
g¹ byÊ przenoszone w†obu kierunkach
podczas jednego procesu synchronizacji.
U†podstaw synchronizacji projektu

w†programach nVisage i†Protel DXP leøy
potÍøny mechanizm porÛwnuj¹cy, tzw.
comparison engine. Mechanizm ten jest
wykorzystywana do porÛwnywania doku-
mentÛw ürÛd³owych (schematÛw) projektu
z†PCB. Mechanizm porÛwnuj¹cy dokonuje
kompletnego porÛwnania wszystkich istot-
nych aspektÛw kaødego projektu, w³¹cza-
j¹c w†to dane elementÛw, takie jak ozna-
czenie, wartoúÊ, model PCB i†zwi¹zane
z†nimi parametry, jak rÛwnieø informacje
o†po³¹czeniach, w³¹czaj¹c w†to nazwy sie-
ci i†ich wÍz³y.
Kluczem do synchronizacji pomiÍdzy

schematem i†PCB jest powi¹zanie kaøde-
go elementu na schemacie z†odpowiada-
j¹cym mu elementem na PCB. W†progra-
mie Protel DXP moøe to byÊ zrobione na
dwa sposoby - poprzez oznaczenie ele-
mentu lub unikalny identyfikator. Stan
powi¹zaÒ elementÛw moøemy sprawdziÊ,
wybieraj¹c polecenie Component Links
z†menu Project w†edytorze PCB. W†oknie
dialogowym widocznym na rys. 6 jest wi-
doczny stan powi¹zaÒ elementÛw. Ele-
menty, ktÛre s¹ powi¹zane za pomoc¹

Rys. 8. W tym oknie jest wyświetlana
lista rozbieżności wygenerowana w efek−

a) b)

Rys. 9. Przykładowe dwa warianty tej samej płyty drukowanej: pozbawiona części

Rys. 10. Widok okna dialogowego
Variant Management, w którym są

unikalnego ID, s¹ pokazane w†czÍúci Mat-
ched Components po prawej stronie ok-
na, zaú elementy, ktÛre nie s¹ dopasowa-
ne przez unikalny ID, s¹ pokazane
w†dwÛch polach po lewej stronie. Pos³u-
guj¹c siÍ kontrolkami u†do³u okna dialo-
gowego, moøemy szybko dopasowaÊ ele-
menty wed³ug okreúlonych kryteriÛw, ta-
kich jak oznaczenie, komentarz czy foot-
print. Moøemy rÛwnieø wybraÊ z†listy
niedopasowane elementy schematu i†PCB
i†powi¹zaÊ je rÍcznie.
Wspomnieliúmy wczeúniej, øe podczas

synchronizacji program bazuje na powi¹-
zaniach elementÛw za pomoc¹ unikal-
nych ID lub oznaczeÒ, ale nie na pod-
stawie innych parametrÛw jak np. footp-
rint czy komentarz. Najlepiej jest dopa-
sowywaÊ elementy, uøywaj¹c unikalnych
ID, poniewaø pozwala to na wiÍksz¹
swobodÍ przy zmianie oznaczeÒ na sche-
macie lub PCB, bez obawy o†utratÍ syn-
chronizacji po renumeracji elementÛw.
Program automatycznie generuje unikal-
ne identyfikatory podczas rozmieszczania
elementÛw na PCB. KoniecznoúÊ rÍczne-
go powi¹zania wystÍpuje rzadko, w†nie-
typowych sytuacjach, kiedy np. rÍcznie
umieúcimy jakiú element wprost z†biblio-
teki na PCB. Wtedy powi¹zania musimy
utworzyÊ rÍcznie, pos³uguj¹c siÍ opisa-
nym wczeúniej narzÍdziem Component
Linking.
SynchronizacjÍ projektu, czyli przeno-

szenie zmian pomiÍdzy schematem i†PCB
uruchamiamy za pomoc¹ funkcji Update
z†menu Design. W†wyniku tego pojawia siÍ
okno dialogowe Engineering Change Order
widoczne na rys. 7, w†ktÛrym s¹ pokazy-
wane wszystkie zmiany, jakie musz¹ byÊ
wprowadzone w†dokumentach docelowych,
aby je zsynchronizowaÊ.
Nie wszystkie rÛønice mog¹ byÊ automa-

tycznie skorygowane - przyk³adowo zmia-
ny po³¹czeÒ nie mog¹ zostaÊ przeniesione
wstecz z†PCB do schematu. W†takim przy-
padku pojawia siÍ szczegÛ³owa informacja
o†liczbie i†przyczynach niemoøliwoúci
przeniesienia pewnych zmian.
Wspomnieliúmy wczeúniej, øe podstaw¹

synchronizacji jest zaimplementowany
w†programie rozbudowany mechanizm po-
rÛwnuj¹cy, ktÛry w†ogÛlnym przypadku
moøe s³uøyÊ do porÛwnywania dowolnych
dokumentÛw projektu np. PCB z†list¹ po-
³¹czeÒ, dwÛch list po³¹czeÒ pomiÍdzy so-
b¹, arkusza schematu lub ca³ego projektu
z†innym arkuszem schematu lub projektem
itp.
Warto przyjrzeÊ siÍ bliøej, jak pracuje

mechanizm porÛwnuj¹cy. Proces wykrywa-

Rys. 7. Widok okna dialogowego Engi−
neering Change Order

nia i†rozwi¹zywania rÛønic przebiega
w†kilku etapach:
- PorÛwnanie widokÛw projektu: typowo
jest to schemat i†PCB. Proces porÛwny-
wania uruchamiamy, wybieraj¹c Update
z†menu Design lub wybieraj¹c Show Dif-
ferences z†menu Project.

- Generowanie listy rÛønic: jeúli wybraliú-
my polecenie Update, to Protel DXP
wie, w†ktÛr¹ stronÍ chcemy przenieúÊ
zmiany, wiÍc okno dialogowe Differen-
ces siÍ nie pojawia. Jeúli wybraliúmy
Show Differences, to wszystkie rÛønice
pokazuj¹ siÍ w†okienku Differences.

- Ustawienie kierunku zmian: moøemy
ustaliÊ kierunek przenoszenia zmian np.
ze schematu do PCB lub odwrotnie,
identyczny dla wszystkich wykrytych
rÛønic lub dla kaødej indywidualnie.

- Generowanie listy rÛønic: po ustawieniu
kierunku zmian, generujemy tzw. ECO -
jest to lista czynnoúci, ktÛre zostan¹ wy-
konane, aby usun¹Ê rÛønice.

- Zastosowanie zmian: uruchamiamy ECO,
aby wprowadziÊ wszystkie zmiany.
Okno pokazane na rys. 8 pokazuje przy-

k³adow¹ listÍ rozbieønoúci wygenerowan¹
w†efekcie uruchomienia mechanizmu po-
rÛwnuj¹cego z†poziomu menu Pro-
ject>Show Differences.

Warianty z³oøeniowe
nVisage i†Protel DXP obs³uguj¹ warian-

ty z³oøeniowe. Tworzymy je, kiedy chce-
my zaprojektowaÊ jeden obwÛd PCB, ale
obsadzony elementami w†rÛønych konfigu-
racjach - kaøda konfiguracja to jeden wa-
riant z³oøeniowy.
Warianty definiujemy po uprzednim za-

projektowaniu kompletnej p³yty PCB. Po
wybraniu z†menu Project>Variants, poja-
wia siÍ okno dialogowe Variant Manage-
ment (rys. 10), ktÛre pokazuje zestaw ele-
mentÛw wystÍpuj¹cych w†ca³ym projekcie.
Moøemy usun¹Ê wybrane elementy z†dane-
go wariantu, ustawiaj¹c opcj¹ Not Fitted
w†odpowiednim miejscu tabeli widocznej
na rys. 10. Dla kaødego wariantu moøemy
wygenerowaÊ w³aúciwe dla niego zestawie-
nia elementÛw, pliki steruj¹ce do maszy-
ny montuj¹cej elementy oraz rysunki mon-
taøowe.
Grzegorz Witek, Evatronix


